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Attachment A

POS Release Notes

Version 14.3 October 18, 2010

These Release Notes contain descriptions of changes in POS Release 14.3 scheduled for October 18,
2010. These have been distributed via HRA email. If you would like to be added to the distribution list,
please contact Sandra Hilton. Prior Release Notes may also be found on the HRA Intranet at
http://hrawebapps/HRAintranet/CMT_page_template.cfm?page id=79
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Attachment A

POS Release Notes

Version 14.3 October 18, 2010

1.

Advantage Program Changes

The Advantage Program is coordinated between HRA and the Department of Homeless Services
(DHS) to provide eligible shelter residents with rental assistance in securing and establishing
permanent housing. The new Advantage Program began on August 1, 2010, and is open to:

= households with children residing in a DHS-funded or DHS-operated shelter/hotel for a minimum of
60 days or an HRA-operated domestic violence shelter for a minimum of 42 days, or New York City
Children’s Services (ACS) youth in group settings aging out of foster care;

= adult households (couples) without minor children residing in a shelter for a minimum of 60 days;
and

= single adults residing in shelters for a minimum of 60 days.

New Housing Advantage Indicator (HAI) Codes

When a household enters the Advantage Program, the Food Stamp (FS) actual shelter expense will be
the family’s contribution amount and will remain the same for the first year of the lease agreement. In
addition, because the Advantage Program rental supplement may exceed the maximum CA shelter
allowance, the household will not receive a CA shelter allowance in their needs calculation. To prevent
staff from entering a CA shelter allowance and to identify the different Advantage programs, the
following new HAI Codes have been developed:

= W - Work Advantage 1st year
= F - Fixed Income Advantage 1st year
= 9 - New Housing Advantage 1st Year (used by ODVEIS)

These new codes will be added to the POS rent expense and budget windows.

Previous HAI Codes:
The previous HAI codes will remain on cases still under year one of the old Advantage Program.

FS shelter allowance must equal $50:

= 1 (Work Advantage [Shelter is $50 or less])
= 5 (HRA Work Advantage [Shelter is $50 or less])

FS shelter allowance must equal $0:

2 (Fixed Income Advantage [Shelter is $0])

3 (Children Advantage [Shelter is $0])

4 (HRA Advantage [Shelter is $0])

6 (HRA Fixed Income Advantage [Shelter is $0])
7 (HRA Children Advantage [Shelter is $0])

Program Confirmation

POS receives a file with clients enrolled in the Advantage programs. In the CA Application Interview,
POS will confirm whether the applicant is in the Advantage Program using the lease start date, the
lease end date and the client’s issuance history.

Rent Expense window edits
In the rent expense window in the CA Application Interview, POS will display the following message
when the system finds that the applicant is enrolled in a new Advantage program:

“This case was found to be an Advantage Rental Assistance Housing Program case where the rent is
pre-paid to the landlord. The shelter type code for this case must be ‘01’. A contribution amount of 30%
or 40% of the income must be entered in the FS Actual shelter amount and the PA shelter amount must
be ‘0’ and there must be a proration indicator of ‘O’ (Letter).
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Attachment A

POS Release Notes

Version 14.3 October 18, 2010

POS will display the following message when the system finds that the applicant is enrolled in an old
Advantage program:

“This case was found to be an Advantage Rental Assistance Housing Program case where the rent is
pre-paid to the landlord. The shelter type code for this case must be ‘01’. If the Housing Advantage
Indicator is listed as anything other than ‘Work Advantage’, the PA shelter amount must be zero, and a
proration indicator of ‘O’ must be entered. If the Housing Advantage Indicator is listed as ‘Work
Advantage’, the PA shelter amount cannot be more than $50”

Special HAI Permission for Housing Program Cases
Housing Program Center (center 018) staff will be able to change the value of the Housing Advantage
Indicator (HAI) for active cases, when necessary. This field will be read-only for all other centers.

Response to

— Shelter Information Actual amount charged

Shelter Type Shelter Code Change Shelter tppe?  for Rent/Mortgage Frequency
|Apt pvt house. .. | ] | & Yes " Mo | $0.00 L =l e

Click to Yiew/Update Details Houszing Advantage Indicator[HAl] Hent Charged To Secondary Tenant

of the Current Shelter Type .00
— Landlord Information — Restriction Information
Has The Household Requested A ’7.
Landorcilivee AL L Rent Restriction Exemption? (" Yes & No
. Rent Restiction Type N
Hame Phone
PA Shelter Amount _

Iz the restriction information the

Houge/PO Box Humber Apt/5uite Humber Same Az The Landlord Information? " Yes (" No
] weee [T

Street Dir Street Hame Street Type

Houze Number or PO .
I | Box B ovse [

City State Zip Street Dir Street Hame Street Type
| Gy — -
r Excess Hent —
Mnnlhl!i'lefl:mess l—ﬂ]l]l] Routing Number | j
DHELE o Scan Comment.
— | |

DK | Cancel ‘

CA Opening Code A30 under status S
CA opening code will be available to Housing Program Center (018) East River Center (037) staff under
CA status of Single Issue (SI) for the processing of Advantage Program cases.

Policy Directive
For budgeting and case processing instructions, and additional information, please see PD 10-31-ELI
Advantage Rental Assistance Program.
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Attachment A

POS Release Notes

Version 14.3 October 18, 2010
2. Changes to M-384 OCSE Appointment Notice

The M-384 (OCSE Appointment Notice) was updated to add an applicant signature. In order to allow
capture of the electronic signature, the printing of the form will be moved from the OCSE Referral
window to the Print Forms window when the OCSE Referral Recommendation is Make a Referral and
the applicant will be scheduled for an in-office OCSE appointment via NYCWAY Action Code 940A
(OCSE Referral).

OCSE Referral Appointment window

OCSE Referral

Instructions

An OCSE Appointmentis necessary for this case. Please click the Make a MNew Appointment” button to request available
appointment dates. If the appointment is already scheduled and you need to change the date of the appointment, click on
the Feschedule the Existing Appointment” button. “rou can cancel the existing appointment by clicking on the ‘Cancel the
Existing Appointrment button, but rermember that you will hawe to schedule a new appointment for this case.

Casename Latest OCSE Appointment Date Office ID
OCSE DCSE | |
Make a New Appoinlmenll Reszchedule Emsting Appoinlmenll Cancel Exzting Appointment
Result of DCSE Appt | Did Not Cooperate Detail I
Follow Up Action I LI
OK LCancel |

Printing the revised M-384 Form

After booking the OCSE appointment, the Worker must access the Print Forms window, select the M-
384 OCSE Appointment Notice and click on the Print button. The M-384 form will be printed and the
eForm Signature window will appear.

The Worker must retrieve the form from the printer and allow the applicant to review the information on
the printed form. Once the information is confirmed and the applicant is ready to sign, the Worker must
place the signature space of the M-384 on the electronic signature pad. The Worker must then click on
the Sign button.

The signature capture window will appear. The applicant must sign the form using the electronic and ink
pen. The Worker must then verify that the signature was successfully captured and click Accept to
save the signature.

The Worker will then click on the Next button. POS will save the M-384 (OCSE Appointment Notice) to
the HRA One Viewer, along with the captured signature.
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POS Release Notes

Version 14.3 October 18, 2010

Print Forms

Version 14.3 - Paperless Office System - [Print Forms]

File Edt Tools ‘Window Help

Joolet = 2]y BB o w4YEaN@ =|($55 &1 |0 ¥ =8
Form Ho Form Description Copies Forms ‘I
EXP_76R Documentation Receipt e-torn
EXP83H D ion of Application for a Social 5 ity Number e-forn
M15 Inquiry R ding Veterans' Benefits and Servi "s All e-forn
M186RR Mandatory Dispute Resolution Action Taken Form
M186TT Mandatory Dispute Resolution No Action Taken Form
W30 Refenral for Social Security Mumber Application =
M327E Sixty-Month Time Limit Checklist e-forn
M384 OCSE Appointment Notice e-for
W36 Motice to Report to Center e-forn
M3MM Motification of Application Withdrawal [Cash Assistance. Food Stamps and Medical Assistance’ e-forn
M40K Notice of Denial of Expedited Food Stamp Processing or Inability to Issue Food Stamp Benefits e-tormn
M4z2q Certification for R ive Medicaid Ci g
[CEb S Medicaid Choice/Managed Care Referral
M528N Request for Child Care Assistance or Request to Close My Cash Assistance [CA) Case e-forn
M858C Notice of Intent to Restiict Home Energy Allowance for Family Assistance Cases [Timely) e-forn
M 858D Utility Guarantee e-forn
MB58FF Motice of Intent to Restrict Home Energy Allowance e-forn
MB58M Utility Arrears/E mergency Heating e-forn

Hext Print Previous

E-Form Signature window

Version 14.3 - Paperless Office System - [eForm Signature Window]

File Edit Tools indow Help

SRS

oy B o wYESN @ =/ $B5® &L [0 o e

Signature - Form Number: M384

Instructions

caontinue. The signed form will be sawed in the elecironic case record.

the form by clicking on the Print button. The printed forrm will not be saved in the elecironic case recard.
Give the printed form to the clientto sign. After the client signs the form, scan and index it into POS.

Fetrieve the form from the printer and place the page on the signature pad. Click on the Sign button. The signature capture
window will appear. Ask the clientta sign and click on the Accept button to sawve the signature. Click on the Next button to

lfthe signature pad is notworking, please check the Unahle to Capture Signatures’ checkbox and select "Signature pad is not warking”
inthe pop-up window and click on the OK button. The POS signature capture fields will be disabled. You must print

F.Signalule
|DEIS E OCSE

[ Unable to Capture Signalures

Hext Re-Print Previoug

== Sign |
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POS Release Notes

Version 14.3 October 18, 2010

Signature Capture window

Aocept | Eraze | Cancel |

3. POS Portal Citywide Implementation

The web-based POS Portal provides a centralized point of access to the Food Stamp Paperless Office
System and several other applications regularly used by FIA Center staff. The user will have one
central location to assist them in accessing, reviewing and processing cases.

The POS Portal will allow access to the Food Stamp Paperless Office System, POS Management
Console and the POS release notes. In addition; the portal will also provide access to the following
Non-Cash Assistance Logs: Application Log, Recertification Log, Deferral Log and the NCA FS
calendars. The web-based Front Door Reception (FRED) application will also be included in the portal.

The POS Portal also provides access to other applications outside of the Paperless Office System. The
following links are available to the user from the POS Portal Home Page:

HRA Home Page

HRA One Viewer

FIA Telephone Recertification Reporting System (IVRS)

Food Stamp Employment Tracking System (FSE)

Automated Child Care Information System (ACCIS)

Public Transportation Automated Reimbursement System (PTAR).
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Attachment A

POS Release Notes

Version 14.3 October 18, 2010
POS Portal Home Page Window

G"‘ x [&) h e e =] 4] 2=
Bl Edt Yew Fgookes Took e
W Erospura | | G-8- -0

& cood Evening ! Today is Monday, September 27, 2000 9:07 P HRA Home Page

Loy o POS Management
NCA FS Application Log
POS (Paperless Office System) Console
NCA FS Recartification L —

Log POS Release Notes

NCA F§ Defarral Log (C:ﬂ(!glcsgm Systam
NCA F8 Calendar :'I:'ll::‘:m‘pnnﬂinn
Reimbursemant (PTAR)

HRA Ona Viewar

Front Door Recaption
(FRED}

FE1a IVRE Tolophomy
Rucert Reporting System

e £, SUFPORT INFORMATION:
POS Help Desk: 718-510-0551  MIS Help Desk: 718-510-8333
fzsi:)p'wmon' Systam WMS Help Desk: 212-961-8047  Autotime Helpdesk: 212-331-3800

Wetwork Control: 710-510-0400 Imaging Help Desk: 710-510-0250

POSWEDS & Local neranst w0 -

Removal of POS Primary and POS Secondary Icons

The POS Primary and POS Secondary icons will be removed from the desktop. Staff must access POS
through the POS Portal icon. To view the POS Sign-On Site, staff must click on the POS (Paperless
Office System) link on the POS Portal.

Appendix
For additional information, please see Appendix B: POS Portal.
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POS Release Notes

Version 14.3 October 18, 2010

4. Single Issuance for FS Separate Determination Cases

The FS Single Issuance windows and transactions will be upgraded to allow direct transmission of
grants from POS to WMS for FS Separate Determination cases at Job Centers. The upgrade will also
centralize printing of back-up grant authorization forms and help eliminate errors in data entry.

Grant Summary window
The Grant Summary window integrates business rules to help ensure accuracy and reduce grant
issuance errors and duplication.

The Worker can view the current case number, the re-use case number (if any), the current center,
grant issuance history and any grants in progress.

To enter a new grant, the Worker will click on the New Grant button. To edit a grant in progress, the
Worker will select the grant and click on the Grant Details button.
Grant Summary window

File Edt JTools ‘Window Help

Case Numbe[FUNINNNSINN  Case Nome: [ EEEE
Re-Use Cage Number EEMEIZ‘MEM’OSB Food Stamp Center

View Grant Issuance History ‘

[Code Description | From / To | Created |Am|NeAmHom Special Status |
mount

Grant Details New Grant
Hext Previous
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POS Release Notes

Version 14.3 October 18, 2010

Grant Issuance History

To view the grant issuance history, the Worker will click on the Grant Issuance History button. They
may view up to 12 months of past grants.

File Edit Tools MWindow Help

Case NI.II'IIhEI__ Case Hame: _ Suffix: |1
|3 vl Months of History ¥ Show FS Grants
Grant codel 'l
Codel Description | From / To | Amount I
Grant Details |
Close |

Benefit Data Entry Window

The benefit data entry window will allow entry of multiple grants at a time. Initially, one grant space will
be available. Once the Worker enters information for the first grant, a second row will appear. After
entering the grants, the Worker will click ‘Done’. Business rules will verify the entered grants against
WMS benefit issuance history and display error messages, if appropriate.

After the business rules pass, the Worker will return to the Grant Summary window.

Deleting a grant
The Worker can delete a grant that was mistakenly entered by:

= selecting the grant in the Grant Summary window;
= clicking on the Grant Details; and
= clicking on the Delete Grant button.
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Single Issue Benefit Data Entry Window — no grants entered

Fle Edit Tools ‘Window Help

Case Numbel:__ Case Name:_

Suffix:|1
Hellse Case Number:l Denlal:lMeIlosa Food Stamp Center
Total grant amuunl:l
— F5 Single Issue Grant Inf b
1.
T e Ende:l ;I P05 Rule Slalus:l
Routing Replaces Authorization
Amount From To Location B enefit Number Check #
} | 00/00/0000 I 00/00/0000

Is this a back-up glant?l " Yes { HNo

Message:

Delete Grant |

Done

Cancel |

Single Issue Benefit Data Entry Window — one grant entered

Fle Edit Tools ‘Window Help

Case NumborSEMMMMMNNEEN  Case Namo: NN

Sulﬁx:|1
Re-lse Case Number:

Cenlal:lMelmse Food Stamp Center

Total grant amount: $27
— F5 Single lssue Grant Inf
1
lssuance [;ude;ll:ode 22 - Daily Retroactive Benefits ;I POS Rule Sla"‘":lr-““m'i
Routing Replaces
Amount

Authorization

From To Location Benefit Number Check #
I $27 | 08/01/2010 I o0g/31/2010 I

Is this a back-up glanl?l " Yes { Mo

Message:

Delete Grant |

— F5 Single lgzue Grant Inf
2
Issuance [:ude;l ;I POS Rule Slalus:l
Routing Replaces
Amount

Authorization

From To Location Benefit Number Check #
I ¢ | 00/00/0000 II]I]II]I]J'I]I]I]I] I

Is this a back-up grant?[C Yes € No

Message:

Delete Grant |

Done

Cancel
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Submission to Supervisor

Once the activity is ready for submission to the supervisor, the Worker will access the Approval
Elements window or will select the Close menu.

Approval Elements window

File Edit Tools ‘'Window Help

=N REAE . T4 B W YEQU A =8 B2 S [F D SR
Disapproved Element =
Address Information Approvall Edit

Disapproval Reasons

Add Comment

Review Comment Log

Dizapproved Element

|Suflix Information

Disapproval Reasons

Approval Edit
Add Comment_|

Review Comment Log

Disapproved Element

Identity.Citizenship.Relationship.Resid & SSN

Disapproval Reasons

Approvall Edit
Add Comment

Review Comment Log

Xt
Hext Previous |

Refer Back to Worker

Activity Includes Ready 51 Grants: [Yes

The Approval Assignment window will appear and indicate whether there are ready grants for the
activity. The Worker will submit the case to the supervisor for approval.

Approval Assignment Window

Approval Assignment

— e e

F5 Supervisor

FS Supervisor

FS Supervisor

F5 Supervisor

No II]I]I]I 0D06BS8E Case NameILI]PIL POLK CIN I
5ul|1 Ca:elnal:IFSPEIS Ea:eheadl SSNI
~Refer Case To
Title UnitI Last Name First Name U | Phone Number d
FS Supervisor

~ Enter C If Any

q

Activity Includes Ready 51 Grants: I?es

Cancel | oK
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Supervisory Review

After the Worker completes their activity, the Supervisor must review the activity, including the Grant

Summary window, and approve or disapprove the processed grants:

The Grant Summary window will track the status of the approval/disapproval.

The supervisor can view benefit issuance history and the detailed entries made by the Worker.

If the supervisor disapproves the grant, a comment will be required.

Grant Summary window in approval activity

File Edt Tools wWindow Help

mount

Case Numbel:_ Case Name:_
Re-lise Case Numherzl Center: [Melrose Food Stamp Center
Yiew Grant Issuance History |
Code Description From / To Amount Next Month| Grant Status

Approval Slatus |

22 22 - Daly Retoactive Benefits

08/071/2010-08/31 /2010

§27.00

Ready

Incomplete

Approval Details |

Benefit approval window

Previous |

File Edit Took MWindow Help

|Grant 1 of 1

Action

" Approve Grant
" Disapprove Grant

r Eror in Grant
Needs Correction

Comment Requirec

Comment Log

Grant Information

Issuance Code: |22

Description:

Amount: $27.00

|22 - Daily Retroactive Benehits

Dates  From: |DBII]1/2I]1EI

Close

To: Iﬂﬂiﬂ‘l /2010

View Grant Details

View Grant History

Hext Grant

Previous Grant
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Grant Form Printing and Transmission

Upon completion of the activity, the grants will be transmitted to WMS, with the exception of back-up
grants with FS grant code 16, which will be submitted to the Single Issue Printing Queue.

Grants Returned to the Worker

If the activity is returned to the Worker, the Disapproved Elements window will display grants that were
disapproved by the Supervisor.

Disapproved Elements window

Fle Edit Tools Window Help

Jo|ol¢ =l o8 w|tHanA =85 &3 e 0| =mnx
Digappraved Element
Single Issuance [requests and special grants) Approvall— Edit
Add Comment
Dizapproval Reazons

Rieview Comment Log

09/15/10 J. Breton, Fs Supervisor: Comment Example for
Disapproved Grant

Disapproved Grants Edit

Code Description From / To Special

08 |03 - Prorated/Partial HPA 01 A5/201-01/31/2011

View Grant History |
F Activity Includes Ready 51 Grants: |Nu
it |
Hext Previous |
Refer, Back to Worker, |
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5.

TALX Information Window Enhancement

The TALX Information window will be updated to automate entries when no TALX match is found.
When the Worker clicks No for “TALX Match Found”, the system will automatically set the following

fields:

= the Ready to
= the TALXOu

TALX Record Outcome field will be set to “Ready”;

tcome field will be set to “TALX was unable to find a Social Security Number match”;

= the Hit field will be set to “No”; and
= the Resolution field will be set to “Nothing to Resolve.”

TALX Information Window

Instructions For &pplicants: Click on the TAL link, located at the top of the TALX information Window, If a match exists, print, scan and index the docurnent. =
Cloze the TALX link. If no match exists, close the TALX link. Proceed to answer questions on the TAL Information Window.
Instructions For Participants: Click on the "System Match' checkbow, If the participant iz known, TAL= will dizplay information from the latest TALX
table. If no information is displayed, proceed to answer question on the TAL information window,

Name

|

Date of Birth

Relationzhip to
Case Head

Social Security
Number

Status (PA/FS)

 Existing information

Who - | Wy TALX LINK System Match [

TALX Match Found? Iz Client disputi ploy t information? Client Stll Employed? s there an RFI Hit:

T Yes 1 Mo " Yes { No [T Yes " No [T Yes © Mo
TALX Employment
Employer Hame Employer Address City State Zip Code

Employment Start Date 00/00/0000 Pay Cycle Gross

TALX Medical

Medical Insurance Coverage? Employee Enrolled? Provider Mame
" Yes " No " Yes " No |
TALX Results

FlA-3A Available?
" Yes ( No

Ready to Record TALX Outcome? @ Ready ' Not Ready
TALX Outcome |TALX was unable to find a Social Security Number malcj

j Comment r

Hit? [C Yes & Mo

Reszolution | Mothing to Resolve

Recertification

Is JOS Worker initiating a Becoupment? If *Yes. amount Recoupment Applicable Program

" Yes " No " CA " FS
Last F5 Grant Benefit Last CA Grant Benefit
Amt. of CA BudgetChange Amt. of F5 Budget Change j
Hext Previous
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6. Document Re-Use Expansion

In many instances, case documents required for eligibility are already available in the HRA One Viewer.
The Document Reuse process facilitates the reuse of existing documents for eligibility factors that do
not require new documentation for each application or recertification, thus reducing the need for
workers to duplicate scanning and indexing of existing documentation.

Whenever a document is required in POS for identity, citizenship or relationship, POS searches the
One Viewer to determine whether the document was previously scanned. Effective October 18, 2010
POS will also look for documentation for resources, absent parent information and alien status for non-
citizen case members.

Example: Documents Found window

Documents found for

Client information in POS

case vumser ([ o i - s o -

Instructions

Images Found in POS Browser/HRA Viewer
Re-Uss
(Document is

I Accurate &
Quostion on Name | ssv |sex| DOB | indexedDate Documentation ‘ Readable)

W
~

New Search

Next = Previous

This window lists all documents found in the image repository related to the individual(s) and eligibility
factors for which documents can be reused. Workers have the ability to view the documents and to use
them as necessary. This window appears prior to the Individual detail window in the POS interviews.

7. New Edit for Homebound Question in POS

A new edit will be added to the Medical window to prevent Workers from removing the homebound
indicator for an individual in POS. If the Worker attempts to change the answer for the question “Is any
Adult in the Household Homebound” from ‘Yes’ to ‘No’ and there is at least one individual with a
homebound indicator, the system will prevent the change from happening and will display the following
error message: “The homebound indicator can only be removed by designated FIA staff.”
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8.

Homebound Data Retrieval in Schedule CA Recertification Appointment

The Calendar window in the Schedule CA Recertification Appointment currently retrieves data from
POS and NYCWAY to determine whether a participant should be scheduled for a home visit
appointment. Additional edits in the window will ensure the retrieval of the homebound indicators from
POS and NYCWAY each time the window opens, if the Worker suspends the activity and returns to it at
a later time.

Reminder: Home Visit Settings in the Calendar window

When the Calendar window opens, POS will make an OpenT] call to retrieve action codes from
NYCWAY to determine whether the client qualifies for a travel accommodation or flexible appointment
hours. The following action codes will be retrieved:

= 16TE (WeCARE Temporary Employment Call-In Exemption)
= 16TT (WeCARE Para-Transit Services Needed)
= 16TH (WeCARE Flexible Appointment Hours)

If NYCWAY action code 16TE or 16TT is found for the casehead, the case will be scheduled for a home
visit. If NYCWAY action code 16TH is found, NYCWAY will provide day and time ranges for which the
client is not available for the recertification appointment.

For Job Center Cash Assistance cases that are not in center 052 (RTSC) and do not have action codes
16TE or 16TT, POS will determine whether the casehead is homebound using POS and NYCWAY
data.

If the casehead is homebound, the question “Does this case require a home visit for face-to-face
(FFR)?” will be prefilled with an answer of “Yes”. The Worker must then select the date and time of the
appointment. The appointment must be at least 10 days in the future.

If the casehead is not homebound, the Worker must indicate whether s/he is an R.E.D. (Returning
Eligibility Determination [BEV]) Worker and whether the case requires a home visit for FFR.

If the case requires a home visit for FFR, the Worker must indicate whether an FFR home visit
appointment was arranged by phone and the date of the phone conversation, if applicable. The Worker
must then select the date and time of the appointment. The appointment must be at least 10 days in the
future.

Expansion of High-Performance Review Pilot to Dyckman and Fordham

The High-Performance Review (HPR) pilot will be expanded from the Linden Job Center to the
Dyckman and Fordham Job Centers. This implementation includes the following functionality:

Full supervisory review of a percentage of selected cases and for cases under HPR exceptions

Disapproval reason selection menu in the supervisory approval windows;

Direct transmission from POS to WMS for non-selected cases;

Implementation of the Notice Selection window;

Implementation of the Notice Printing Queue for centralized printing of client notices at the HPR Job

Centers;

» Printing and mailing of six client notices by MIS (EBT-23, LDSS-3152, LDSS-4013, LDSS-4753 and
M-3mm); and

= Implementation of the Worker-Only Activity and AJOS 2 Review reports in the Management

Console.
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10.Reminders: High Performance Review (HPR) Pilot

Selection of DSS-3574 and DSS-3575 forms in Notice Selection Window
The HPR pilot has implemented the Notice Selection window.

In this window:

= The DSS-3575 form will only be selected when there are CA grants that will not be transmitted to
WMS (Pick-Up Code 4, 5 or 7) or that are back-up grants.
= The DSS-3574 form will only be selected when the FS grants are marked as back-up grants.

These forms will not be selected when all grants will be transmitted directly to WMS by the final level of
approval.

Required WMS TTSS bits for Transmission of Grants
New staff members in a center with the HPR pilot require the following WMS TTSS Bits to transmit
grants to WMS:

= 0158 — Expedited Food Stamps (EFS)
= 0178 — Food Stamp Single Issue (FS SI)
= 0229 — Public Assistance Single Issue (PA SI)

Requests for these security bits must be submitted to the Office of Data Security Management (OSDM)
via the Auto Paperless Access Request Transmission (APART) system.

11.Automated Medicaid Separate Determination (MSD)

If an applicant/participant is denied or becomes ineligible for Cash Assistance (CA), for a reason that
does not apply to the eligibility requirements for Medical Assistance (MA), a separate Medicaid
determination is required. An applicant may choose to apply for CA and Food Stamps (FS) and not
apply for MA. In such cases, if the CA application is denied, a separate determination for MA is not
required.

A new process will be created to automate processing for cases where Medicaid Separate
Determination (MSD) is required. For cases requiring MSD, POS will submit MA-relevant data and
documents entered on the CA case to the Eligibility Data and Image Transfer System (EDITS) for
processing of the MA decision or deferral for required MA documentation.

Determination for MSD Required, MSD Not Required and Manual MSD Review Required

POS will receive nightly files from the NYC MAPPER system of individuals with eligibility decisions
processed five business days earlier. These files will indicate whether the case was reopened since the
initial decision and whether the individual was found in an open status (AP, AC, Sl or IC) on a Cash
Assistance or Medicaid case.

The cases found with an open status will be marked as not requiring MSD. For cases with a closed CA
status, POS will verify whether the closing was a single issue closing. If the closing was not a single
issue closing, the case will be marked as not requiring MSD because the closing code will determine
where MA is continued.

If the CA eligibility transaction was completed outside of POS, the case will be marked as requiring
manual MSD review.

POS will submit MA relevant data and documents to EDITS for processing of the MA decision or a
deferral for required MA documentation.
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12.

13.

14.

POS will update the case activity history for the CA case with the outcome of this system review for
MSD.

Policy Directive
For additional information on the existing MSD policy and process, please see PD 10-23-ELI| Separate
Medicaid Determinations.

Posting of NYCWAY Action Code 11DU (No Longer a Childcare Provider)

When the applicant/participant answer is Yes for the question “Does the Applicant/Participant claim
they stop providing childcare?” in the ACCIS Clearances window, POS will post action code 11DU (No
longer a childcare provider) to NYCWAY. The code will be posted when the Worker clicks the Next
button in the window.

Appendix
For additional information, please see Appendix B: ACCIS Clearances.

New Approved Amount Edit for Single Issue Grant Requests

A new business rule will compare the total grant amount entered for a grant request in the data entry
window (Sl Task 7) against the approved amount entered in the Referral and Outcomes section in Si
Task 6. If the amounts differ, the following warning message will appear: “Approved amount in Sl Task
6 does not match entered grants”.

New Interview Data Edits for Single Issue Grants

New business rules will warn the Worker that an expense was not recorded in POS interview when they
attempt to record certain grant types.

When the Worker enters CA grant codes 10 (Utility grant to prevent turn off/restore services [prior to
PA]), 41 (Utility grant to prevent turn off or restore utility services [mismanagement]) or 50 (Non-
recoupable utility grant [no mismanagement]) in the Data Entry window, but did not record a gas/electric
expense and did not enter a heating bill expense, the following message will appear: “Gas/electric
expense was not recorded and heating bill expense was not recorded in the interview.”

When the Worker enters CA grant codes 09 (Rent only), 30 (Rent payments in excess of maximum), 31
(Pre-PA rent arrears), 39 (Rent in advance to secure apartment), 40 (Rent in advance to prevent
eviction), 43 (Accrued rent while on PA), 59 (NYCHA rent arrears), 75 (Rent held in escrow) or 77
(Court ordered retroactive payment), but did not record the rent expense, the following message will
appear: “Rent expense was not recorded in the interview.”

When the Worker enters CA grant code 05 (Pregnancy allowance), but did not record the pregnancy
and expected date of confinement (EDC) in the interview, the following message will appear:
“Pregnancy was not recorded in the interview.”
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15.Single Issue Reminders: Removing Grants Associated with a Grant Request

Occasionally, the Worker may mistakenly mark a grant request as accepted and begin the data entry of
single issue grants.

To correct the decision and remove grants associated with a grant request that is not ready to receive
grants, the worker must access Sl Task 6 and mark the request as Not Ready in the Grants tab.

If the request will be denied or will be accepted without issuing a grant, the Worker must access Sl
Task 6 and:

= Select a decision of Deny and enter the denial reason; or
= Select a decision of Accept, select Other Action and enter the action taken on the case.

When these steps are completed, the grants will be deleted from the system.

16.Pre-filling Center in Case Transfer with Covering Center for Zip Code

In the CA Case Transfer activity, POS will prefill the New Center menu with the center covering the
participant’s residential zip code. The Worker can change the prefilled value if the case will be
transferred to a different center.

17.Sorting by Date and Time in CA Login Queue

Workers and Supervisors will be able to sort the Login Queue by the Date and Time columns.

Version 14.3 - Paperless Office System - [Activities Management] 115452PM  Tussdav, Sentember 28, 2010

File Edt Tools ‘Window Help

[o] ® ) #m e w]

F Action | EE 040 C& Supervizor Queue Eéf Login Queue |
LOGIN QUEUE
Date Time E| ED ‘Log First Name Last Name Program | Primary | Speak| Paper| Mail | Cannot Alert Assigned Si
m | Dap Mo Lang Eng | Case|or |Stay Message Ta
g Feop Fax
al | ul
Start Assign Left Center Requested Retum Reopening Update Disposition | WS | Wiew Y'our Schedule | Eommentl
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18.WMS 2010.3 Change: New BVI Indicator

The Medicaid program currently requires applicants to document their citizenship status and identity
when applying for health insurance benefits. As an alternative for US born citizens with validated SSNs
having to present original documentation, certain CA/MA and MA-only cases will be matched against
the State Verification and Exchange System. The system will match against individuals meeting the
following criteria:

Active for MA

Alien Citizenship Indicator = C (Citizen)

SSN Validation code = 7 (SSN Assigned by SSA) or 8 (SSN Validated by SSA)
BVI (Birth Verification Indicator) field = BLANK

Alien Number field = BLANK

SSl indicator does not = 1(Active) or 4 (Deemed Eligible)

On Friday, October 15, 2010, all active CA/MA and MA-only individuals will have the BVI indicator
changed from blank to 5 (Deemed Verified).

Update to POS TAD
The BVI (Birth Verification Indicator) field will appear on the POS TAD next to the DGC field.

Beginning Monday, October 18, 2010, staff must enter a “3" (Verified by Worker) in the BVI field for
each MA eligible individual who submits original documentation to verify his/her US citizenship and
identity in the POS TAD.

The following are common examples of documents can be used to verify citizenship and/or identity.

U.S. Passport

U.S. Birth Certificate
Naturalization Certificate
Baptismal Certificate
Hospital Records
Military Service Records

For a complete listing, refer to the form DOH-4418 (Identity and Citizenship or Immigration Status for
the Medical Assistance Program), which can be accessed at: http://health.state.nyenet/docs/ldss/doh-
4418.pdf

If the Worker attempts to input any value other than 3, the following error message will appear: “The
BVI value can be replaced by ‘3’ only”

If the applicant is not a U.S citizen or does not provide proof of her/his citizenship and identity, then the
BVI field should be left blank.

The BV indicator is not valid on FS only cases, or FS only individuals on a CA case.

The BVI field will also be updated through the current Unborn/Newborn Match process. When an
Unborn/Newborn is added to a MA or CA/MA case the BVI code will be 2. This is a system generated
code and cannot be changed. This code only verifies the child’s citizenship, for CA purposes all other
eligibility factors must be verified (i.e., relationship, residency etc.)
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POS TAD window

Varsion 14.3 - Paperless Office System - [TAD Data - Eligibility] 11:58:24 PM_ Tuesday, September 23, 2010
File Edit Tools Window Help
Jol@lt ma|li|py B ojwvyFan@ = $3 e &840 F|wmEE
WS Data POS Data
First Hame Last Name Middle Name Sex Marital Status Buy-In Indicator  + |
Hisianic!Latinu Asian Hiilii Hiiiliii iiii iiilii |i|irdel
Wumerican Indian/Alaska Native Black or African American White
Reuse CIN  Relation to Casshead  DGC J] BYI [§ Birth Date TPHI AD-EX
[ [Casehead =] I | [oo/00/0000
— STATE/FEDERAL overage CBIC 55N
State/Federal Code Date Code From Date To Date CC CDC Mumber Valid | Student ID
[ _~| [o0700/0000 [ [o0/00/0000 [00/00/0000 | [ [ | NN -0
Line No CIN Citizen/Alien Status
|_1 RJAB109E Citizen Alien Type Alien No Date of Status LRl e
il =1 [00/00/0000 00/00/0000 L
BCS TASA
I Eal | K|
Emp Code 551
I e |
OTH YET
I = =l
Highest Degiee Earned Code Education Level
=] [ 1
Individual Cat Code Mother of Child Override 2
I =l : : =]
Waivers Indi
’7 D/A I¥D LF TL Oth ’7 TL-EX AFIS-EX
Save Changes | | =l | =l LI
Hext | Previous | Ignore Errors | IReturn to Case level Data| Run Rules |

If the current value for the field in WMS is 1 (Verified), 2 (Verified through automated newborn process),
4 (Verified via EDITS/POS) or 5 (Deemed Verified [System Generated]), the Worker will not be able to
change the value for this field in POS.

New BVI (Birth Verification Indicator) field on WMS Inquiry Screens NQIN2A and NQCPO03
A new indicator named BVI (Birth Verification Indicator) will be added to the WMS inquiry screens
NQINZ2A (Client Information) and NQCPO03 (Pending Individual Data). This field will be used for
citizenship verification on Medicaid cases.

New BVI (Birth Verification Indicator) field on Clearance Report and Individual Data Screen

In addition to being on the TAD (Item# 366), the BVI indicator will appear on the Clearance report
adjacent to the DOB (date of birth) field, and will be added on the INDIVIDUAL DATA screen (Screen
No: NCEM15) under the Eligibility in Data Entry Mode. This indicator will be added next to the “EPI”
field.

Policy Directive
For additional information on the usage of this new indicator, please see the Policy Directive for the
WMS 2010.3 version.
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19.Default Mailing Address for Undomiciled Applicants and Participants

An entry in the mailing address fields is required for undomiciled applicants and participants. If the
applicant or participants does not provide a mailing address, the default General Post Office address for
the borough is used for the case. At the request of the United States Postal Service, the street address
for these default addresses will be changed to GENERAL DELIVERY. The word GENERAL will go in
the Street No field and the word DELIVERY will go in the Street Name field.

||:'"3313"t Address I Is the applicant/participant undomiciled? * Yes " Mo 1=
Type Apt i City
St No/Dir/Name: [39 |INone] _x||Undomiciled | =l [Bronx
State: IW Zip Code: IW Phone: l--—
M ailing Address I Does the applicant/participant have a mailing address?  Yez * Mo
Care of Hame: IWhite C Type Apt & City
St No#Dir/Name: [RENER{ [[None] - |[DELIVERY | =l [Bron:
State: IW Zip Code: IW Phone: l--—

20.Fix for Flow for Failed to Keep Recertification Cases

21.

22.

When the case is marked as “failed to keep” in the FTK FFR window in the CA Recertification
Interview, the activity for the CA Recertification Interview and Approve CA Recertification should
be limited to the following windows:

= Household Screen

= FTKFFR

= TAD

= Approval Elements

When the Worker clicked on the “Previous” button on the TAD, POS mistakenly displayed the full
window set for the activity, rather than the shortened flow. This issue will be fixed in the October 18
release.

E-Forms
The following E-Forms will be updated:

M-384, OCSE Appointment Notice

LDSS-3152-NYC, Action Taken on Your Food Stamp Case (NYC)

W-34A, Referral/Information Form

W-519, Finger Imaging Notice

W-607A, Request for Identification Card/Temporary Medicaid Authorization/Update Existing CBIC

Reminder: TAD transmissions Prevented for an Inactive case

When the Supervisor clicks on the Xmit (Transmit) button in the Approval Elements window, POS will
compare the current CA case status in WMS and the CA case status selected in POS. The TAD
transmission will not be posted if both the WMS CA and POS CA case statuses are inactive.

In these instances the following message will be displayed:

= This case is inactive in both WMS and POS TADs. No TAD or Grant transmission needs to
be posted.
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23.Single Issue Reminders: Re-Printing Grant Forms

Once the Print Grant Forms row is completed in the Single Issue Printing Queue, the form cannot be

printed from this queue.

To reprint S| grant forms that were printed using the Single Issue Printing Queue, the worker must
access the Review Case activity, click the Next button in the Activities window, select Tools and click
on Printed Forms. The Worker can select the form and click on the Preview button to review the

form(s) prior to printing. The Re-Print button will allow the Worker to re-print the form(s).

Activities window

File Edit Tools Window Help

ot el ol B

Suffic| 1

No [00007421939F

Case Name IPERKINS SAM

CIN |TB§4379A

Casehead Name F.iam Perkins

55N [055-88-3107

Seq# Activity Type

Reason For Removal

Parent

Start Date

E
End Date Emy

| 2045 ‘ Document Intake

|4!12NU1:14pm |4m2mu1:14pm|

I 2043 ‘System Removed

| 2040 |2n1ms:30 am |2mr10 530 am ISYSTEM

| 2042 ‘Prim & Form

| 2041 |2110m01:04 pm |2m0r101:04 pm IEdouard

| 2041 ‘Prirﬂ & Form

|2n 0A01:04 pm |2m 0M01:04 pm IEdouard

| 2040 ‘Wa'ning o See You

<

|2m1mn 5:30am I.Jnse Bre

o

Hext

Tools > Printed Forms Menu

|Too|s Window  Help

WS
WS Inquiry ... Alt+I
Current Active Budget Alk+E
Ledger Alt+G
Ackivity Inquiry in NYCWAY
Clearances
TALX file

I RFIData
Reparts
WMS TAD ... Ale+T
Print Quewes

| Language Access Tracking

. | Printed Farms ||

I Docurnents Alb+Dr
Comments Alb+r

Cancel
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Printed Forms window

Ho. Copies DateTime =
Activity StartDate  End Date Employee Form Printed CH Stamp

I (dss3575)d_dss3576 1

i

Hon-Food Emerg/Special 22472004 36612004 Shepard Michele  (dss3574)d_dss3574 1 00000000 27242004 11:33 am

Grant

CA Application Interview 2132004 35512004 Shepard Michele  (w113k)Documentatidn 00000000 21372004 12:21 pm
Requirements

CA Application Interview 2132004 35512004 Shepard Michele  (m3)Action Taken on®our 00000000  2A13/2004 12:18 pm
Application

CA Application Interview 2132004 35512004 Shepard Michele  (citizenc)Certificationtof 00000000 21372004 12:01 pm
Citizenship

4 | _»lJ

Preyiew | Re-Print | Close |

24.Reminder: Appendices

=  Appendix A, POS Portal

= Appendix B, ACCIS Matches Update with New NYCWAY code 11DU
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Overview

The web-based POS Portal provides a centralized point of access to the Paperless Office System and
several other applications regularly used by FIA Center staff. The user will have one central location to
assist them in accessing, reviewing and processing cases.

The POS Portal will allow access to the Paperless Office System, POS Management Console and the
POS release notes. In addition; the POS portal will also provide access to the following Non-Cash
Assistance Logs: Application Log, Recertification Log, Deferral Log and to the NCA FS calendars. The
web-based Front Door Reception (FRED) application will also be included in the portal.

The POS Portal also provides access to other applications outside of the Paperless Office System. The
following links are available to the user from the POS Portal Home Page:

HRA Home Page

HRA One Viewer

FIA Telephone Recertification Reporting System (IVRS)

Food Stamp Employment Tracking System (FSE)

Automated Child Care Information System (ACCIS)

Public Transportation Automated Reimbursement System (PTAR).

POS Portal Home Page Window

UsHortaljLerault, aspx

Human Resources
Administratio
Department of

Sof':rioal

2 Good Morning ! Today is Friday, May 28, 2010 10:27 AM HRA Home Page

MCA FS Application Log POS Management

POS {(Paperless Office System) console
NCA FS Recertification S, POS Release Notos
Log
NCA FS Deferral Log E::g(d:lcéire System

Public Transportation
Automated
Reimbursement {PTAR)

NCGA FS Calendar

HRA One Yiewer

Front Door Reception
(FRED)

FIA I¥RS Telephone

Recert Reporting System 3 .

auney 5 sy £, SUPPORT INFORMATION:

Es Empl + svet POS Help Desk: 718-510-0551  MIS Help Desk: 718-510-8333

(FSE';')" oyment System WMS Help Desk: 212-961-8042 Autotime Helpdesk: 212-331-4800
MNetwork Control: 718-510-0400 Imaging Help Desk: 718-510-0250
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Definitions

NCA Food Stamp Application Log

The Application Interview Log allows Food Stamp (FS) Centers to assign and reschedule application
interviews and allows the processing of failed to keep transactions by designated staff.

» Human Resources
Administration
Department of
Social Services

NCA FS Application Log

Enter your WMS User ID and Password to login

userio ||

Password |

FS Sites |Fordham Food Stamp Center (F44) ~l

[LoGIN || cLEAR |

i If wou forget your password please contact Help desk: 718-
P pos Portal @ HRA Home @ Help 510-0551 or send email to: Helpdesk-POS@hra.nyc.gov

NCA Food Stamp Recertification Log

The Recertification Interview Log allows Food Stamp (FS) Centers to view their past, current and future
Recertification Interview appointments, to assign and reschedule their Recertification Interviews.

» Human Resources
Administration
Department of
Social Services

NCA FS Recertification Log

Enter your WMS User ID and Password to login

User ID _ — o
Password -
FS Sites i_FDrd. an od a_mp_Center (F44) v:
[LoGiN &> || cLEAR |
s If you forget your password please contact Help desk: 718-
“? pos Portal A HRA Home o Help 510-0551 or send email to: Helpdesk-POS®@hra.nyc.gov
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NCA Food Stamp Deferral Log

The Food Stamp Deferral Log will allow Food Stamp Centers to close NCA FS cases in Single Issue
(SI) status that were deferred for documentation and failed to return with the requested documentation.

y Human Resources
Administration
Department of
Social Services

NCA FS Deferral Log

Enter your WhKHS User ID and Password to login

User ID |
Password

FS Sites :Nort’l';l BrDDk"\}I"I Food Stamp Center 7(’F26) ~|
R | e |

. If yvou forget your password please contact Help desk: 718-
P pos Portal #® HRA Home @) Help 510-0551 or send email to: Helpdesk-POS@hra.nyc.qov

NCA FS Calendar

The NCA FS calendar gives FS Site Managers and Assistant Site Managers the ability to create and
maintain application appointment slots for designated NCA and CBO staff. In addition, FS Site Managers
and Assistant Site Managers will have the ability to create new calendars as needed.

y Human Resources
Administration
Department of
Social Services

NCA FS Calendar

Enter your WhKHS User ID and Password to login

User ID |
Password
FS Sites :FDrdHam Food Stamp Center 7(’F44) ~|
R | e |
. If yvou forget your password please contact Help desk: 718-
P pos Portal #® HRA Home @) Help 510-0551 or send email to: Helpdesk-POS@hra.nyc.qov
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The POS portal also provides external links to other HRA applications that assist the FIA managers and
workers in maintaining, updating, processing and reviewing cases.

HRA One Viewer

Provides FIA staff with the ability to search and retrieve documents and document-related information.

address | 8] http:, hra.nycne default.aspx V\ = Go
Human Resources HERA OneViewer
Administration
Department
Social Services Welcome to HRA Oneviewer!
user Name | Details |
password [ | HR4 One Viewer is an effort to present dacument/image related information on HRA. Clients from all repositories within HRA, The viewer s a web
z = application and is a product of efforts from Imaging Unit within Office of Services Systems at HRAMIS, The wiewer will offer the following features on
ecoastily e 1
Forgot Password? » Search documents/images using Case Number, SSN, CIN, Scanned Date Range, Department,/Program and many other advanced search
criteria

o Wiew and Frint refrieved images if neeced

o Ferform library or department specific search

« Sart search results in ascending or descending order

« Wiew search results in TABS with document grouped and organized
« Frint all retrieved documents within TABS as a batch

» 45 admin, add/modify delete users to the application

« Integrate the viewer application with new and legacy applications

Front-Door Reception (FRED)

Application assist the receptionist at Job Centers/NCA Sites in routing applying individuals and those in
receipt of benefits to the correct location within the offices.

y Human Resources
Administration
Department of
Social Services

Front Door Reception (FRED)

Enter your WHS User ID and Password to login

User ID | |

Password |

MO Sites :Vgrt Green ood Etamp Center &FZd) ~

[LociM > |[ cLEAR

If you forget your passwaord please contact Help desk: 718-
“® pos Portal # HRA Home @ Help 510-0551 or send email to: Helpdesk-POS@hra.nyc.qov
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Interactive Voice Response System

IVRS provides certain NCA FS households with the opportunity to recertify for benefits by use of an
automated telephone response system.

HRA Telephone Recert Reporting Sys

[ First time user and need a User ID and Fassword? Click here :l

[ Already hawve a User ID and Password, please sign in below

-

Usexr ID || |

Pasword | |  Loam |

[ Forgot your User ID or Password? Click here

—

@ City of New ¥York, HRA

Food Stamp Employment system (FSE)

This system facilitates the management, enroliment and tracking of FS participants who are potentially
required to participate in work activities.

MYS| Food Stamp Employment/Syste

Environment: TEST

Log In

Already hawve a User ID and Password, please sign in below

User ID: | |

Password: [ |

MY C.gow Home Page | Privacy Statermment

These computerized systems are legally confidential and proprietary to the State of Mew Tork, its offices of

Temporary and Disability Assistance, and related agencies and mavy be accessed only by lawfully authorized
entities. Federal, state, and local laws and regulations protect the confidentiality of the Humman Resources
Aadministration's clients. all clients' documents accessed by HRA staff and sponsoring programs are to be
used solely for the purposes of providing services. Unauthorized access to aor release of systern data may
entail both civil liability and criminal prosecution.
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Paperless Office System

The Paperless Office system assists FIA staff in developing, processing and maintaining the NCA and
Cash Assistance caseloads in an electronic case record.

P fresolanon=1 280 TUZF

. H R
< POS SIGN ON m Rumetaten T
? Department of
Social Services

8 GoOD MORNING! WOOHOO, IT'S FRIDAY?

g INSTRUCTIONS:

1. Choose your site frorm the dropdovwn lists below according to the site's function.

2. Readthe message(s) in the Message Center area [it refreshes itself every 10 minutes]
3. Checkifyou chose the right site in the "Confirm Selection” panel which will appear.

4. Connectto the selected site (green button), or choose another =ite (red button).

@5 CA SITES: €5 FOOD STAMPS SITES: € TRAINING SITES: € HASA SITES:

CHOOSE THE SITE ~ CHOOSE THE SITE ~ CHOOSE THE SITE CHOOSE THE SITE

¥, SUPPORT INFORMATION:

rour User D s HILT4244 FOS Help Desk: 718-510-05571
Tour PC name is: W1SMTC 160888 WS Help Desk: 212-0961-8042
four Screen Resolution is: 1280x1024 Metwork Control: 718-510-0400

Flease email Help Desk - POS ifyou have any problems

FRIDAY, MAY 28, 2010

Management Console

The management console houses reports designed to assist management and supervisory staff in their
operational process.

POS Management Console

>
éﬁy‘*‘!,nc User Guide

N Local
—
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POS Release notes

Links to all published release notes located on the HRA Intranet.

Friday, May 28, Z010 - 10:55 A HOME | SITE ADMIN | SITE MAP | HELP |
HF~ Home > Help > HRA POS Release Motes
hee Topxcs Help -- Technical Support
PC Introduction --= POS Release Notes
Fad's --=
Contact Informmation —-> wielcorme to the POS Release Motes section of the HRA Help! On this page, wou can find surmraary and
Forrms and Deocurments detailed descriptions of POS enhancernents, Please distribute these docurments to all POS case rmanagers
T T and all ather interested parties.
Date Summary Detail
February 2010 Hia BElros release 14.1-detall
February 2010 i EFs POs release 4.1-
detail
Jamuary 2010 EIPOS release 13.3.1- Eros release 13.3.1-
SUMImary detail
January 2010 EFS POS release 3.3.1- EIFs POS releases 3.3.1-
SUmmary detail
Cctober 2009 @DDS release 13.3- @DDS release 13.3-
sSUmmary detail
Oetober 200a  EFS POS release 3.3- BEIFs POS release =.3-
SUmimany detail
August 2o0s  BEIPOS relesse 13.2.1- Eros release 13.2.1-
SUMImary detail
August zo0o EFS POS release 3.2.1- EIFs POS releases 3.2.1-
sSUmmary detatil
June 2002 Eiros release 13. 2-summary Eiros release 13, 2-detail
Tume 2o0g EHFS POS release 3.2- EFs POs release 3.2-
SUMImary detail
May 2009 rrn ElrModel Office 5.0
Relaase
February 2009 Hia Elros release 13.1-detall
February 2009 i EFs POs release 3.1-
detail
_ =

Automated Child Care Information System (ACCIS)

ACCIS provides an integrated child care payment system that contains information on all active
participants.

PLEASE CLICK ON THE BUTTON BELOW TO CONNECT TO ACCIS
[ accis ]
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Public Transportation Automated Reimbursement System (PTAR)

Metro card ordering system for FIA centers.

B D SC S DD ST JTOCT . Sepe

l}ﬂmmm L‘;za@@mm@ga ammnsaug@mava@m
&1 £ T

PRODUCTION ENVIRONMENT

User ID: | | | Cogin

Password: | |

The POS Portal will provide direct links to all of the previous noted applications. The external applications
outside of POS (HRA OneViewer, ACCIS, IVRS, etc.) will open in their own window allowing the worker
the ability to access and navigate the application fully.

All POS related applications will link back to the POS portal which would save time by providing access to
all the featured applications. This portal will be updated to include access to other applications as they
become available in the future.
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ACCIS Clearances Window

POS will now identify applying or active individuals who are also identified as child care providers
receiving payment via the Automated Child Care Information System (ACCIS). POS will launch an
automated lookup to ACCIS using the applicant/participant social security number at the time of
application and recertification.

If matches are found, a new ACCIS Clearances window will appear in the CA Application Interview, EC
— CA Application Interview, CA Recertification Interview and EC — CA Recertification Interview
activities after the Worker clicks the Next button in the Absent/LRR window.

If there are communication problems between POS and ACCIS, the following error message will appear:

= “The communication between POS and ACCIS has failed. Please try again later using the tool bar
option under clearances.”

ACCIS Clearance Window

Version - POS - ACCIS Clearances

Instructions

The Clearance below represent a Social Security Match in the ACCIS system for the applicant/Participant, You must
chose a resolution in order to complete an Activity before case is forward for supervisory Approval
—.Applicant/Participant Demographics in POS ddress information in POS
Name SSN DOB 163 East 178" Street 4H
John Doe 111-22-3333 12/12/1980 Bronx, NY 10453
~—Information from Childcare system (ACCISS)
Child Care Child Care Last First ACCIS ACCIS
Provider SS# Provider # Name Name Address Status
111-22-3333 746352 Doe John 225 Wesl 22nd street NY NY 10011 AC
~— Gross Income for the last five Months
Is the icant/Participant
January 09 | February 09 | March09 | April 09 May 09 m‘.:,?' this Match? Ove Ok
200.60 255.30 300.00
Resolution
Is Participants
Was this child care income previously budgeted (JYes (No () Pending
Was a FIA-3A initiated and Conpleted? with the correct amount?
Was a recoupment initiated due to the child care
()Yes (ONo () Pending income match?

| Next

Previous I
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POS Information
The top section of the window will include the applicant/participant demographics and address information
in POS.

—Applicant/Participant Demographics in POS

ddress information in POS

Name SSN DOB 163 East 178" Street 4H

Bronx, NY 10453

John Doe 111-22-3333 12/12/1980

ACCIS Information
The middle section of the window will include the applicant/participant demographics and address
information in ACCIS.

~—|nformation from Childcare system (ACCIS)

Child Care Child Care Last First ACCIS ACCIS
Provider SS# Provider # Name Name Address Status
111-22-3333 746352 Doe John 225 Weslt 22nd street NY NY 10011 AC

ACCIS Gross Income Information
The lower section of the window will provide the gross income pay information from ACCIS for the last
five months (if any).

Gross Income for the last five Months

January 09

February 09

March 09

April 09

May 09

200.60

255.30

300.00
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Client Match Dispute
The Worker will need to indicate whether the applicant/participant is disputing the match.

Is the Applicant/Participant () Yes (i No
disputing this Match?

If an applicant is disputing the match, the following message will appear: “You must make a proper
referral to the Bureau of Eligibility Verification (BEV)” in the “Referrals” window”.

If a participant is disputing the match, the following message will appear: “You must make a proper
referral to Bureau of Fraud Investigation (BFI). Select the link in the Help Menu and submit Form BFI-14."

If the applicant/participant is not disputing the match, the Worker will need to indicate whether s/he claims
that s/he stopped providing child care.

Does the Applicant/Participant
Claim they stopped providing | i¥es [ No
R bt o i

If s/he claims that s/he stopped providing child care, the following message will appear:

“You must capture applicant/participant signature. If the signature pad is not working, you must print the
form, have the applicant/participant sign it, then scan and index into the OneViewer. You must also, go to
ACCIS and terminate childcare payments.”

The signature capture for form W-274U (Attestation of Employment as a Childcare Provider) will appear.
The Worker must capture the applicant/participant signature using the electronic signature pad or must
have the applicant/participant sign the manual form and scan and index it into the OneViewer.

Resolution
The Worker will need to indicate a resolution for the ACCIS match information.

————Resolution
Applicants Participants
Was this child care income previously budgeted (J¥es (JNo () Pending
Was a FIA-3A initiated and Conpleted? with the correct amount?
Was a recoupment initiated due fo the child care P oy
O)Yes (No () Pending income match? Livesi( o)

For applicants, the Worker will need to indicate whether an FIA-3A was initiated and completed. There
are three options under this menu:

= Yes
= No
= Pending

If the answer is No, a comment window will open and the Worker should provide a detailed explanation
on why the FIA-3A was not initiated and completed.

For participants, the Worker will need to indicate whether the child care income was previously budgeted
with the correct amount and whether a recoupment was initiated due to the child care income match.
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Completion Edit

If the Worker indicated a resolution of Pending and they attempt to complete the application or
recertification activity, a completion edit will require answers in the resolution section. The ACCIS
Clearances window will open and the following error message will appear:

= For applicants: “You must answer the question “Was an FIA-3A initiated and completed” of the
resolution section of this window”

= For participants: “You must complete the participant’s questions” of the resolution section of this
window”

NYCWAY Action Codes
When a match is found in ACCIS, POS will post the following action code to NYCWAY:

= 11DP (Active CC provider review Pool)

When the Worker indicates that a recoupment was initiated due to the child care income match, POS will
post the following action code to NYCWAY:

= 11DB (Active CC provider recoup initiated)

When the applicant/participant answer for Yes for the question “Does the Applicant/Participant claim they
stop providing childcare?” in the ACCIS Clearances window, POS will post the following action code to
NYCWAY when the Worker clicks the Next button in the window:

= 11DU (No longer a childcare provider)

Supervisory Approval
The ACCIS Clearances window will be added in the following approval activities and will appear when
ACCIS matches are found:

Approve CA Eligibility Decision
Approve CA Recertification

Approve EC — CA Application Interview
Approve EC — CA Recertification

The Supervisor will need to approve or disapprove the Worker’s entries in this window. The Approval
menu will be available under the Window > Approval menu option.
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Supervisory ACCIS clearance window

Version - POS - ACCIS Clearances

Fie Edt Toos Window Help

Instructions

t a Social Security Match in the ACCIS system for the applicant/Participant, You must
complete an Activity before case is forward for supervisory Approval

—Applicant/Participant Demographics in POS —Address information in POS
Name SSN DOB 163 East 178" Street 4H
John Doe 111-22-3333 12/12/1980 Bronx, NY 10453

~|nformation from Childcare system (ACCISS)

Child Care Child Care Last First ACCIS ACCIS
Provider SS# Provider # Name Name Address Status
111-22-3333 746352 Doe John 225 Wesl 22nd street NY NY 10011 AC

—— Gross Income for the last five Months e
Applicant/Participant
January 09 | February 09 | March 09 April 09 May 09 disputing this Match? OYes ONo
200.60 255.30 300.00 Does the
Claim they stopped providing
o O¥esiONal
—————Resolution
is ———Participants
Was this child care income previously budgeted () Yes (O)No () Pending
Was a FIA-3A initiated and Conpleted? with the correct amount? _
Was a recoupment initiated due to the child care
OYes ONo () Pending income match? O¥es O

| Next Previous

Approval menu

Supervisory Approval 1
Dis. oval Reasons Comment Log

OK | LCancel |
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Tools Menu Access to ACCIS Employment Clearances
In addition, a new option named ACCIS Employment Clearances will be added to the POS Toolbar
menu under Tools > Clearances to allow the worker to do an ACCIS search at any other POS activity.

Version 14.2 - Paperless Office System - [Household Screen]
Fil=  Edit | Toaols ‘Window Help

[ = wms w | EeM e e B
_ WyP1S Inguiry ... Aale+1
Suffixh ) de WHMS Message via OLTE
||]|]|]|]|]|]1 current Active Budget ALE  H48 CASE NUMBER NOT FOUND
Ledger Ak
Control ackiveiby Inguiry in MY WAy
District - Clearances Vital Records K
TaLx File Building Clearance I
Fresen RFI Diata 3 DYy
Board of Educakion
Reports * Subsidized Housing Caollateral Daka
WS TaD ... Alk+T AFIS Resulks
Mon-Citizen 551 Collater] Daka

— Prink Queues
Suffix In Language Access Tracking

=1 S Empl ek C =l

m Printed Forms
F5 Suff e T F5 Status INA
Comments AlE+14 PA MA Monthly
Suff | S < Lak # ALC Stat # ALC Rent
Digital Sender Image Indexing
m Ukility Liaison Queue I L I LLE: I L I QUD00

Hext P, Last PA Recert datel £

e Mass Caseloading
Case M onic ¢ Food Stamps

Suff Ln Relation DOB
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